Preface
Basics of Time Stamping
Structure
Systems and components
Configuring Time Stamping
AS Process Control Messages for Time Stamp Faults

03/2009
ASE02122528-01
Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ **DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ **WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ **CAUTION**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

⚠️ **CAUTION**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

⚠️ **NOTICE**
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel
The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Proper use of Siemens products
Note the following:

⚠️ **WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks
All names identified by © are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Preface .......................................................................................................................... 5
2 Basics of Time Stamping ................................................................................................. 9
  2.1 Basics of High-precision Time Stamping ................................................................. 9
  2.2 Time stamping of signal transitions ........................................................................ 11
  2.3 The time stamping process ...................................................................................... 12
  2.4 The time stamping process in the interface module ................................................. 14
3 Structure ....................................................................................................................... 17
  3.1 System planning and configuration ......................................................................... 17
  3.2 Hardware Configuration .......................................................................................... 18
  3.3 Special features of the interface module ............................................................... 20
  3.4 High-precision time stamping with 1 ms accuracy ............................................... 21
4 Systems and components ............................................................................................ 23
  4.1 Overview: Systems and components .................................................................... 23
  4.2 SIMATIC station ..................................................................................................... 24
  4.3 Communication modules ........................................................................................ 24
  4.4 Distributed I/O ....................................................................................................... 25
  4.5 IMDRV_TS block .................................................................................................. 27
  4.6 Signaling block ...................................................................................................... 28
    4.6.1 MSG_TS block ................................................................................................... 28
    4.6.2 Blocks of the Advanced Process Library (APL) .............................................. 29
  4.7 Time master ........................................................................................................... 30
# Table of contents

5 Configuring Time Stamping ................................................................................................................. 31
5.1 Overview of configuration tasks ........................................................................................................ 31
5.2 Configuring the networks .................................................................................................................. 33
5.2.1 Configuring the networks ............................................................................................................ 33
5.2.2 How to configure the CP 443-1 (Industrial Ethernet) .................................................................. 34
5.2.3 How to configure the Ethernet connection for a CPU 41x PN/DP ............................................. 35
5.2.4 How to configure the CP 443-5 Extended ................................................................................. 37
5.2.5 Rules for assigning the time interval ............................................................................................ 38
5.2.6 How to configure the PROFIBUS connection of the CPU ....................................................... 39
5.3 Configuring the ET 200M station ...................................................................................................... 41
5.3.1 Setting options on the ET 200 station ........................................................................................ 41
5.3.2 How to configure the interface module ...................................................................................... 42
5.3.3 Examples of settings for IM 153-2 interface module ................................................................. 45
5.3.4 How to configure the SM 321 digital module ............................................................................. 47
5.3.5 Examples of settings for SM 321 digital input module .............................................................. 49
5.3.6 How to configure the SM 131 digital module ............................................................................. 50
5.3.7 Example of settings on the SM 131 digital input module ......................................................... 52
5.3.8 How to configure the SM 326 digital input module ..................................................................... 53
5.3.9 Examples of settings on digital input module SM 326 section .................................................. 55
5.4 Configuring symbolic names ............................................................................................................. 56
5.4.1 How to configure symbolic names for signals ........................................................................... 56
5.5 Configuring the signaling block ....................................................................................................... 58
5.5.1 How to prepare for message configuration ................................................................................ 58
5.6 Configuring the input signals .......................................................................................................... 59
5.6.1 How to configure the input signals ............................................................................................ 59
5.7 Configuring messages for high-precision time stamping ............................................................... 63
5.7.1 How to configure messages with the MSG_TS block ............................................................... 63
5.7.2 How to configure messages with blocks of the Advanced Process Library (APL) ................... 64
5.8 Compiling and downloading the AS ............................................................................................... 66
5.8.1 How to compile and download the AS ..................................................................................... 66
5.9 Compiling and downloading the OS ............................................................................................... 67
5.9.1 How to compile and download the OS ...................................................................................... 67
6 AS Process Control Messages for Time Stamp Faults ........................................................................ 69
6.1 Time stamp faults ............................................................................................................................. 69
6.2 AS process control message "Startup data" ..................................................................................... 70
6.3 AS process control message "Time-of-day message frame error" .................................................. 72
6.4 AS process control message "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" ......................................................................................... 73
6.5 AS process control message "STOP of the time stamp function" .................................................. 74
6.6 AS process control message "Message loss at IM (buffer overflow)" ............................................. 75
6.7 AS process control message "Redundant changeover" .................................................................... 76
6.8 AS process control message "Loss of information with redundancy" .......................................... 77

Index....................................................................................................................................................... 79
Preface

Purpose of this documentation

This documentation provides you with a full overview of the topics relating to the use of high-precision time stamping:

- Required components
- Interaction of the components
- Configuration of the components

The first section gives you an overview of the option and use cases for high-precision time stamping and is intended for the following readership:

- Future users of SIMATIC PCS 7
- Persons responsible for deciding on the use of a control system
- Sales personnel and system configuration engineers either within Siemens or belonging to other companies

The subsequent sections show the configuration and parameter assignments for high-precision time stamping and is intended for persons involved in the following occupations:

- Conceptual design of PCS 7 solutions
- Device and system programming
- Configuration and commissioning
- Servicing

Required basic knowledge

General knowledge in the area of automation engineering and process control engineering is required to understand this documentation.

It is assumed that the reader knows how to use PCs or other equipment similar to PCs (such as programming devices) operating under Windows operating systems approved for PCS 7.
Changes compared with the previous version

Below you will find an overview of the most important changes in the documentation over the previous version:

PCS 7 V7.1 or later

- The IMDRV_TS and MSG_TS blocks replace the IM_DRV in the PCS 7 library. Message texts are retained following a future update of the library.
- High-precision time stamping using blocks from the Advanced Process Library (APL)
- High-precision time stamping with redundant signal acquisition
- You will find information about time synchronization in the Process Control System PCS 7; PCS 7 Time Synchronization function manual.

As of PCS 7 V7.0 SP1

- Interface modules IM 153-2 (types: 6ES7153-2BA02-0XB0 and 6ES7153-2BA82-0XB0)
- Fail-safe detection of up to 24 signals with the module SM 326 (6ES7326-1BK01-0AB0)

Validity of the documentation

This documentation is valid for the software package Process Control System; PCS 7 Toolset as of V7.1.

Conventions

In this documentation the designations of elements of the user interface are specified in the language of this documentation. If you have installed a multi-language package for the operating system, some of the designations will be displayed in the base language of the operating system after a language switch and will, therefore, differ from the designations used in the documentation.

PCS 7 Glossary

You will find a PCS 7 glossary containing definitions of important technical terms used in this documentation on the DVD SIMATIC PCS 7; Manual Collection or in the PCS 7 software via the SIMATIC Manager Help menu (menu command Help > Contents > "Glossary" button).
Further Support

If you have any technical questions, please get in touch with your Siemens representative or responsible agent.

You will find your contact person at:
http://www.siemens.com/automation/partner

You will find a guide to the technical documentation offered for the individual SIMATIC Products and Systems at:
http://www.siemens.com/simatic-tech-doku-portal

The online catalog and order system is found under:
http://mall.automation.siemens.com/

Training Centers

Siemens offers a number of training courses to familiarize you with the Process Control System SIMATIC PCS 7. Please contact your regional training center or our central training center in D 90327 Nuremberg, Germany for details:

Telephone:   +49 (911) 895-3200 *)
Internet:  http://www.sitrain.com
Technical Support

You can reach the Technical Support for all Industry Automation and Drive Technology products

- Via the Web formula for the Support Request
  http://www.siemens.com/automation/support-request
- Phone:  + 49 180 5050 222 *)
- Fax:    + 49 180 5050 223 *)

Additional information about our Technical Support can be found on the Internet pages
http://www.siemens.com/automation/service

Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at:
http://www.siemens.com/automation/service&support

where you will find the following:

- The newsletter, which constantly provides you with up-to-date information on your products.
- The right documents via our Search function in Service & Support.
- A forum, where users and experts from all over the world exchange their experiences.
- Your local representative for Industry Automation and Drive Technology.
- Information on field service, repairs, spare parts and consulting.

*) Please note the following if you call the phone number listed: You may incur costs which vary from the standard costs for land lines. Calls from a cellular network may be more expensive.
Basics of Time Stamping

2.1 Basics of High-precision Time Stamping

Introduction

This documentation describes the time stamping function for digital input signals. Users can activate time stamping in their system configuration and display the time information in their monitoring system.

Definition

The following is meant when referring to time stamping in this documentation:
The assignment of time information with a high degree of accuracy about the state changes of an acquired process signal.
The detection of changes in digital input signal states and the assignment of time information are performed by SIMATIC components.

Application

Possible applications for high-precision time stamping are:
• Accurately-timed detection of problems in process-related equipment. Time stamping enables you to explicitly identify signals that indicate the cause of the failure of a process unit.
• Analysis of system-wide interrelationships
• Detection and reporting of the sequence of time-critical signal changes
• Time-precise acquisition of signal changes in fail-safe devices

Requirement

The time must be synchronized on all the devices belonging to the system. The devices are connected to a time master for this purpose.
2.1 Basics of High-precision Time Stamping

**Precision**

The following applies to high-precision time stamping:

- If process signals are acquired from a separate PROFIBUS DP master systems and results arrive simultaneously at the input module, the time stamps of the resulting messages in the HMI system differ by maximum x milliseconds (see table below). The accuracy depends on the I/O used.
- The time stamping does not depend on whether the PROFIBUS DP master systems are located in one or more SIMATIC 400 stations.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Achievable precision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>1 ms</td>
<td>With ET 200M, you can acquire signal changes with selected digital input modules with an <strong>accuracy of 1 ms</strong>. You can find information about this in the section &quot;High-precision Time Stamping with 1 ms Accuracy (Page 21)&quot;.</td>
</tr>
<tr>
<td>ET 200M</td>
<td>10 ms</td>
<td>With ET 200M, you can acquire signal changes with selected digital input modules with an <strong>accuracy of 10 ms</strong>.</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>20 ms</td>
<td>With ET 200iSP, you can acquire signal changes with selected digital input modules with an <strong>accuracy of 20 ms</strong>.</td>
</tr>
<tr>
<td>ET 200M</td>
<td>20 ms</td>
<td>During fail-safe signal acquisition with ET 200M, you can acquire signal changes with selected digital input modules with an <strong>accuracy of 20 ms</strong>.</td>
</tr>
</tbody>
</table>

**Resolution**

The displayed resolution of the time is 1 ms (regardless of the precision).

**Advantage**

The high-precision time stamping does not depend on cycle times.

**Property**

The high-precision time stamping can only be used for digital input modules.

**Additional information**

You can find more information about the released digital input modules in the section "Components and Systems".
2.2 Time stamping of signal transitions

Time-precise acquisition

The use of time stamps makes it easier to analyze the causes of problems.

Example

If a boiler used to produce steam fails, this event causes a surge of messages:

- The temperature and pressure fall below a specified limit value, the flame monitor responds, the next plant unit signals "steam low", etc.
- To determine the actual cause of the failure, the first message in this surge of messages must be identified (for example, "gas pressure too low").
- Since a large number of messages will arrive following the failure of a plant unit, a resolution of 1 second for the message time is inadequate. With the aid of time stamps, the signals that led to the shutdown of the boiler are selectively detected. As a result, the operator can evaluate the cause of the shutdown more easily.

Plant-Wide Interrelationships

A further aspect of 10 ms time stamping is the determination of interrelationships between units in a plant.

Example

The high-precision time stamping is implemented throughout the plant:

By comparing the time stamps of relevant signals throughout the plant, a momentary quality impairment in a unit can be traced to a problem in another unit.
2.3 The time stamping process

Description

The following table describes the time stamping sequence.

The digital inputs of a module in the distributed I/O station (ET 200M, ET 200iSP) are monitored for signal transitions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Who/Where?</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IM</td>
<td>The interface module IM (IM 153-2, IM 152-1) stores the signal state change.</td>
</tr>
</tbody>
</table>
| 2    | IM         | The interface module IM (IM 153-2, IM 152-1) stores the information about an "incoming event" with the current time in a message list (in the IM). Features:  
  • The time resolution of the time stamping is 1 ms.  
  • Special messages are also saved in the message list (events influencing message processing).  
  • A maximum of 20 messages in a message list form one data record.  
  • An IM stores up to 15 data records. |
| 3    | IM         | The interface module IM (IM 153-2, IM 152-1) triggers a hardware interrupt on the DP master (for example, SIMATIC station S7-4xx) if one of the following events occurs:  
  • A message list (data record) in the IM is full.  
  • There is at least one message in a message list after 1 second. |
| 4    | CPU        | The CPU reads the reaction to the process alarm (OB 4x) from the data record. |
| 5    | IMDRV_TS   | Driver block IMDRV_TS reads the data records of the interface module (IM 153-2, IM 152-1) and transfers the information to signal the following block:  
  • When using the "PCS 7 Library": MSG_TS block  
  • When using the "APL" library: Pcs7DiIT block  
  The information of the input signal is stored temporarily in Pcs7DiIT.  
  The message texts are saved to the signaling block by default (you can find additional information on this in the "AS process control messages for time stamp faults" section). |
| 6    | Signaling block:  
  • MSG_TS  
  • APL blocks: | Signal path depending on the employed library:  
  • When using the "PCS 7 Library", the MSG_TS block reads the time stamp directly from the output of the IMDRV_TS driver block.  
  • When using the "APL" library, the APL block reads the time stamp through the Pcs7DiIT block from the output of IMDRV_TS.  
  The signaling block sends the message to the operator station. The message text depends on the configuration (see the paragraph "Additional information").  
  The configuration in HW Config defines which signal transition 0 > 1 or 1 > 0 is to be reported as "INCOMING". The "OUTGOING" message is generated when the state reported by "INCOMING" changes.  
  The signals with a time stamp are entered without gaps and in ascending chronological order in the message list of the operator station. |
| 7    | Synchronization | All the operator stations and SIMATIC stations used in the system must be supplied with the same time:  
  • The time master regulates the time synchronization for time stamping.  
  • Various time masters are available, for example:  
    • "SICLOCK TC 400"  
    • "Real-time transmitter for Industrial Ethernet" |
Additional information

- Section "How to configure messages with the MSG_TS block (Page 63)"
- Section "How to configure messages with blocks of the Advanced Process Library (APL) (Page 64)"
- Operating Instructions SIMATIC; Distributed I/O Device ET 200M
- Operating Instructions SIMATIC; Distributed I/O Device ET 200iSP
2.4 The time stamping process in the Interface module

Principle

The figure below shows how signal transitions are time stamped in the interface module (IM 153-2, IM 152-1).

- **Startup of the ET 200 station is completed.** The interface module is ready for data communication with the DP master.
- **Is the suitable time stamp parameter available for configuration?**
  - **Yes:** Clock set in the interface module?
    - **Yes:** Generate startup data: read the states of the configured digital inputs; process interrupt on DP master for reading message buffer.
    - **No:** Error message on DP master; Digital input signals are not time-stamped. “Normal” data communication with DP master is not affected thereby.
  - **No:** Clock in the interface module
    - **Read time frame**
    - **Set the clock of the interface module**
    - **Current time**

- **Time is set to 01.01.2006; 00:00**

- **Monitoring of the configured digital inputs:** At change, generate message and enter it in the message buffer.
- **Diagnostics of the time frame:** At failure or time jump greater than the configured tolerance, generate special message and enter it in the message buffer.
- **Process interrupt on DP master; for reading message buffer**

- **Redundancy?**

- **With redundancy, the passive interface module always has an image of the time stamp messages.**
Note

Startup synchronization

A time stamp with the value "01.01.1984" will be sent if the interface module is not synchronized during startup. The events are correctly assigned a time stamp following the automatic configuration (synchronization) by the CPU.
Basics of Time Stamping

2.4 The time stamping process in the interface module
3.1 System planning and configuration

By implementing the steps listed below, you can ensure that messages are saved in the archive even when a buffer overflow occurs (for example, when a device failure occurs):

- When planning your system and during configuration, ensure that the signals to be acquired are distributed uniformly throughout the system.
- Check the applicability of the modules. You can find more information about this in the section "Systems and components (Page 23)."
- Only configure time stamping for relevant signals in SIMATIC stations with heavy loads. You can find more information about this in the section "Basics of High-precision Time Stamping (Page 9)."
- Configure uniform module types.
- Configure a maximum of 128 digital inputs for each ET 200 station. Configure only digital inputs in the ET 200 stations.
- Set identical delay times for the inputs.
3.2 Hardware Configuration

Introduction

You use the distributed I/O based on ET 200M or ET 200iSP to acquire the signals. This section provides an example of a hardware configuration needed for time stamping.

Example system with time stamping

The following figure shows an example of a system configuration with time stamping.

[Diagram of a system configuration with time stamping]
Example plant with time stamping in the fault-tolerant automation system

You can also use the time stamping function together with an S7-400H and distributed I/O:

- With an ET 200M, you can create a redundant configuration even to the sensor (fully redundant distributed I/O).
- With an ET 200iSP, you can connect to a redundant PROFIBUS DP (redundant interconnection).

Below you will see an example of a system using ET 200M.

Additional information

- You will find information about time synchronization in the *Process Control System PCS 7; PCS 7 Time Synchronization* function manual.
- You can find information about the IM 153-2 interface module in the manual *Distributed I/O Device ET 200M*.
- You can find information about the IM 152-1 interface module in the manual *Distributed I/O Device ET 200iSP*.
- You can find information about the redundant configuration of a distributed I/O in PCS 7 in the following documentation:
  - Manual *Process Control System PCS 7; Fault-tolerant Process Control Systems*
  - Manual *Programmable Controller S7-400H, Fault-Tolerant Systems*
3.3 Special features of the interface module

Introduction
The interface module (IM 153-2, IM 152-1) message buffer can become overloaded if there is a signal surge or if too many signals are constantly reported. Such an overload can result in the loss of messages. When planning your system you must ensure, therefore, that the interface module message buffer is not overloaded.

Message surge
When "unusual" events occur (for example, failure of a plant unit), signal transitions can occur almost simultaneously.

This behavior can be explained by analyzing the technological interrelationships.

Example
The frequency of signal transitions in a system can be projected as follows:
- On average, approximately 2% of the signals change per second.
- In the worst case (such as the failure of a plant unit), approximately 30% of the signals change state per second.

Message loss
If all the time-stamped signals of a system are collected on one ET 200 station, messages can be lost on the relevant interface module when "unusual" events occur. The message loss is displayed according to the cause using AS process control messages (you can find additional information in the "AS Process Control Messages for Time Stamp Faults (Page 69)" section).

Example for 10 ms time stamping
A system with ET 200M has 1,500 digital signals in its final configuration:
- Based on the projection, 450 signals per second can change in this system in the worst case.
- If numerous signals with high-precision time stamping are configured in an ET 200M station, for example, when there are 8 SM 321 digital input modules each with 16 inputs, messages can be lost due to the following reasons:
  - Other system-internal messages are generated in addition to the process messages (you can find additional information in the section "AS Process Control Messages for Time Stamp Faults").
  - The following processing levels (interface module, IMDRV_TS blocks, AS message processing, MSG_TS blocks and OS message processing) require more time to evaluate process messages (slow execution cycle of the blocks is set).

Additional information
- Operating Instructions SIMATIC; Distributed I/O Device ET 200M
- Operating Instructions SIMATIC; Distributed I/O Device ET 200iSP
3.4 High-precision time stamping with 1 ms accuracy

Configuration rules

- Synchronize the automation system via a time master, such as SICLOCK TC 400.
- Use the following modules in the automation system:
  - Interface module IM 153-2 (e.g. 6ES7153-2BAx1-0XB0, see "Distributed I/O" section)
  - Digital input modules of the ET 200M
- Use the 6ES7321-7BHxx-0AB0 digital input module for high-precision time stamping.
- Install the digital input module (6ES7321-7BHxx-0AB0) for processing the input signals with high-precision time stamping gapless starting with slot 4.
- Configure an identical input delay for all digital inputs with high-precision time stamping to a minimum value (100 microseconds).
- Leave the process interrupts deactivated.
- When configuring the plant, ensure that there is no repeater in the signal path between the CPU of the automation system and an ET 200M in the DP master system on which the digital inputs are acquired with high-precision time stamping.
- Do not evaluate the digital inputs with high-precision time stamping before the startup time of ET 200M has expired (at least 10 seconds).
- Use appropriate sensors for acquiring the signals.

Note
Keep the properties of the sensors in mind.
Input signal junctions can have differing effects on the accuracy of the time stamping. The varied response is effected by such criteria as:
- Ramp times
- Spikes
Restriction

The following events may be the cause for temporary degradation of the accuracy of the high-precision time stamping:

- Processing of diagnostic results
- Firmware update
- Reading identification and maintenance information (I&M data)
- Other acyclical services

Validity

The accuracy of the high-precision time stamping with 1 ms accuracy applies per DP master system.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The accuracy of the high-precision time stamping between several DP master systems with an accuracy of 1 ms is 10 ms.</td>
</tr>
</tbody>
</table>
Systems and components

4.1 Overview: Systems and components

Introduction
This section presents the systems and components required for time stamping of digital input signals.

Systems
The HMI system in the PCS 7 process control system is an operator station. The automation system in the PCS 7 process control system is a SIMATIC station.

Components
The following components are used for converting time stamping of digital input signals:

- SIMATIC station (Page 24)
- Communication modules (Page 24)
- Distributed I/O (Page 25)
- IMDRV_TS block (Page 27)
- Signaling block according to the implemented function:
  - MSG_TS block (Page 28)
  - Blocks from the Advanced Process Library (APL) (Page 29)
- Time master (Page 30)
4.2 SIMATIC station

SIMATIC stations

You can use S7-400 and S7-400H series CPUs in the SIMATIC stations for processing messages and forwarding them to the operator stations.

4.3 Communication modules

Communication modules

You can use the following communication modules for time stamping:

- CP 443-1
- CP 443-5 Extended

Note

You can use the PROFIBUS DP connection of the CPU instead of the CP 443-5 Extended.

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>CP 443-1</th>
<th>CP 443-5 Extended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used as ...</td>
<td>... interface to the plant bus</td>
<td>... interface to the distributed I/O device</td>
</tr>
<tr>
<td>Used to establish connection between ...</td>
<td>... SIMATIC station and operator station</td>
<td>... SIMATIC station and distributed I/O device</td>
</tr>
<tr>
<td></td>
<td>CP 443-5 Extended forwards the stamped messages transferred via the PROFIBUS DP (field bus) to the CPU.</td>
<td></td>
</tr>
<tr>
<td>Connection to bus system</td>
<td>Industrial Ethernet (plant bus)</td>
<td>PROFIBUS DP (field bus)</td>
</tr>
<tr>
<td>Order No.</td>
<td>6GK7 443-1EX11-0XE0</td>
<td>6GK7 443-5DX04-0XE0</td>
</tr>
<tr>
<td></td>
<td>6GK7 443-1EX10-0XE0</td>
<td>6GK7 443-5DX03-0XE0</td>
</tr>
<tr>
<td></td>
<td>6GK7 443-1EX02-0XE0</td>
<td>6GK7 443-5DX02-0XE0</td>
</tr>
<tr>
<td>Mounting</td>
<td>In the SIMATIC station slots in the rack (universal rack - UR)</td>
<td>In the SIMATIC station slots in the rack (universal rack - UR)</td>
</tr>
</tbody>
</table>
4.4 Distributed I/O

Distributed I/O

Time stamping can be configured with the following distributed I/O devices:
- ET 200M
- ET 200iSP

The following modules are used in the distributed I/O device to acquire signals:
- Interface module for PROFIBUS DP for preprocessing the signals
- Digital input modules for detecting signal transitions

---

Note
Discontinued modules

The modules that can currently be ordered are described in this documentation.

The following applies when using modules approved for high-precision time stamping in past versions of PCS 7:
Verify their continued use in PCS 7. You can find additional information on this in the documentation Process Control System PCS 7; Released Modules.

---

Interface modules for PROFIBUS DP

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Order No.</th>
<th>Product version</th>
<th>Precision</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7153-2BA01-0XB0</td>
<td>All</td>
<td>1 ms (20 ms for fail-safe signal acquisition)</td>
</tr>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7153-2BA02-0XB0</td>
<td>All</td>
<td>1 ms (20 ms for fail-safe signal acquisition)</td>
</tr>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7153-2BA81-0XB0</td>
<td>All</td>
<td>1 ms (20 ms for fail-safe signal acquisition)</td>
</tr>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7153-2BA82-0XB0</td>
<td>All</td>
<td>1 ms (20 ms for fail-safe signal acquisition)</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>IM 152-1</td>
<td>6ES7152-1AA00-0AB0</td>
<td>1.0 (&gt;=2.0 for redundant interface)</td>
<td>20 ms</td>
</tr>
</tbody>
</table>

High-Precision Time Stamping (V7.1)
Function Manual, 03/2009, A5E02122528-01
Digital input modules

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Order No.</th>
<th>Used as</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7321-7BH01-0AB0</td>
<td>Module for process signal acquisition: 16 electrically isolated inputs (24 VDC) and diagnostic messages, redundant signal acquisition possible</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7321-7RD00-0AB0</td>
<td>Module for process signal acquisition: 4 inputs (NAMUR), suitable EX area, redundant signal acquisition possible</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7321-7TH00-0AB0</td>
<td>Module for process signal acquisition: 16 inputs (NAMUR), redundant signal acquisition possible</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 326</td>
<td>6ES7326-1BK01-0AB0</td>
<td>Module for acquisition of process signals: • 24 inputs for use in interface module 6ES7153-2BA02 • 12 inputs (CH 00 to CH 11) for use with interface module 6ES7153-2BA01 • redundant signal acquisition and fail-safe signal acquisition possible</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>SM 131</td>
<td>6ES7131-7RF00-0AB0</td>
<td>Module for process signal acquisition: 8 inputs (NAMUR)</td>
</tr>
</tbody>
</table>

Modules for higher environmental requirements

You can use functionally equivalent SIPLUS modules for higher environmental requirements.
### 4.5 IMDRV_TS block

#### Using the IMDRV_TS block

The IMDRV_TS block is a driver block. IMDRV_TS performs the following tasks for time stamping:

- Transmits time-stamped process signal changes to the MSG_TS and Pcs7DiIT blocks
- Transmits non-specific events (special messages) to the OS

When time stamping is configured for an AS, the "Generate Module Drivers" function inserts IMDRV_TS automatically in a CFC chart (system chart). The names of these CFC charts begins with the "@" character. One IMDRV_TS is inserted for each interface module.

The IMDRV_TS reads the messages from the message buffer of an interface module and transfers the time stamp and process signal changes to the signaling block (MSG_TS message block (Page 28) or Blocks of the Advanced Process Library (APL) (Page 29)).

#### System messages

IMDRV_TS outputs AS process control message if an error is detected in high-precision time-stamping.

#### Additional information

Additional information on the diagnostics response of the IMDRV_TS is available in the CFC online help for IMDRV_TS.
4.6 Signaling block

4.6.1 MSG_TS block

Using the MSG_TS block

The MSG_TS block is a message block of the PCS 7 Library for signals with high-precision time stamping. MSG_TS is used to generate time-stamped process messages. MSG_TS forms the interface between the outputs of the IMDRV_TS block and the ALARM_T message function.

Insert MSG_TS in a CFC chart if you want to use time stamping. MSG_TS can send messages to up to 16 digital inputs.

Messages

MSG_TS reports any changes to the assigned digital inputs by means of two integrated alarm blocks (ALARM_8P).

Additional information

As of PCS 7 V7.1, you can find additional information about the messages and the response of MSG_TS in the online help for the MSG_TS block of the PCS 7 Library.
4.6.2 Blocks of the Advanced Process Library (APL)

Signal detection with the channel driver block
If blocks of the Advanced Process Library (APL) for input signals are to be given a high-precision time stamp, you must use the following channel driver blocks for signal detection: Pcs7DiIT.

Using blocks of the Advanced Process Library
The following blocks from the APL can send process messages with high-precision time stamps:
- EventTS block
- APL blocks for controlling motors and valves
The channel driver block Pcs7DiIT forms the interface between the outputs of the IMDRV_TS block and the APL block.

Messages
The signaling block has an integral alarm block (ALARM_8P). This alarm block signals a change to the assigned digital input.

Additional information
You can find additional information about the messages and the response of the blocks in the online help for the Advanced Process Library.
4.7 Time master

Time master

The time master distributes the time signal to operator stations and SIMATIC stations that need to be synchronized.

We recommend using SICLOCK TC400 (SICLOCK TM) as the time-of-day master:

- The time master synchronizes connected stations requiring synchronization via Industrial Ethernet/Fast Ethernet.
- The time master can be synchronized using a time signal from a SICLOCK GPS decoder, or SICLOCK DCFRS receiver, for example.

Additional information

- You can find information and ordering data about to the SICLOCK TM components that can be used in PCS 7 in the ST PCS 7.1 catalog (add-ons for PCS 7).
- You can find information about time synchronization for a PCS 7 plant in the function manual Process Control System PCS 7; Time Synchronization.
5.1 Overview of configuration tasks

Requirement
The components of the automation system are inserted in HW Config. The figure shows an example configuration for time stamping in HW Config:

Overview of configuration tasks

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configuring the CPs: (Page 33)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the CP 443-1 (Industrial Ethernet) (Page 34)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the PROFINET IO connection of the CPU (Page 35)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the CP 443-5 Extended (Page 37)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the PROFIBUS connection of the CPU (Page 39)</td>
</tr>
<tr>
<td>2</td>
<td>Configuring the ET 200M station:</td>
</tr>
<tr>
<td></td>
<td>- Power supply (no configuration necessary)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the interface module: IM 153-2/IM 152-1 (Page 42)</td>
</tr>
<tr>
<td></td>
<td>- Digital input modules:</td>
</tr>
<tr>
<td></td>
<td>- Configuring the SM 321 digital input module (Page 47)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the SM 131 digital input module (Page 50)</td>
</tr>
<tr>
<td></td>
<td>- Configuring the SM 326 digital input module (Page 53)</td>
</tr>
<tr>
<td>3</td>
<td>Configuring the symbols (Page 56)</td>
</tr>
<tr>
<td>4</td>
<td>Configuring the signaling block (Page 58)</td>
</tr>
<tr>
<td>5</td>
<td>Configuring the input signals (Page 59)</td>
</tr>
<tr>
<td>6</td>
<td>Configuring the messages for high-precision time stamping (Page 63)</td>
</tr>
</tbody>
</table>
5.1 Overview of configuration tasks

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Compiling and downloading the AS (Page 66)</td>
</tr>
<tr>
<td>8</td>
<td>Compiling and downloading the OS (Page 67)</td>
</tr>
</tbody>
</table>

Additional information

- Online help for *HW Config*
- List *PCS 7 - released modules*
5.2 Configuring the networks

5.2.1 Configuring the networks

The following is described in this section:

- Configuring the CP 443-1 (Industrial Ethernet) (Page 34)
- Configuring a CPU with integrated PROFINET IO connection for connecting to Industrial Ethernet (Page 35)
- Configuring the CP 443-5 Extended (Page 37)
- Configuring the PROFIBUS connection of the CPU (Page 39)

Synchronization of the automation system

A master clock is required on the plant bus for the time synchronization of the automation system. We recommend you use the SINEC TC 400 master clock.

The following options are available for the interface of the automation system to the plant bus:

- Ethernet interface of the CP 443-1
- Integrated PROFINET IO connection of selected CPU types

PROFIBUS master

The PROFIBUS master is the component that distributes the system time to the PROFIBUS. You can use the following components as the PROFIBUS master:

- CP 443-5 Extended
- Internal PROFIBUS connection of the CPU
5.2.2 How to configure the CP 443-1 (Industrial Ethernet)

The following procedure is based on SIMATIC stations connected to Ethernet via CP 443-1. If the CPU is connected directly to Ethernet via an integrated PROFINET IO connection, the SIMATIC station is synchronized using NTP. Additional information is available in the section "How to configure the Ethernet connection for a CPU 41x PN/DP (Page 35)".

Requirement

A CP 443-1 is configured in the configuration table for the SIMATIC station (type of CP: See section "Components and Systems > Communication modules (Page 24)").

Procedure

1. Select the CP 443-1 in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Time-of-Day Synchronization" tab, select the "Enable Time-of-Day Synchronization in SIMATIC Mode" check box:

   ![Time-of-Day Synchronization Settings]

4. Click "OK" to apply the settings.
5.2.3 How to configure the Ethernet connection for a CPU 41x PN/DP

The following procedure is based on SIMATIC stations in which one of the following CPU types are used:

- CPU 414-3 PN/DP
- CPU 416-3 PN/DP

This CPU type is synchronized via NTP. We recommend the SINEC TC 400 as the time master.

If the CPU is connected directly to Ethernet via a CP443-1 communication processor, the SIMATIC station is synchronized using the SIMATIC protocol. Additional information is available in the section "How to configure the CP 443-1 (Industrial Ethernet) (Page 34)".

Requirements

- The CPU is connected directly to Ethernet (plant bus).
- The time master is connected to the plant bus.

Procedure

1. Select the CPU in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Time Synchronization" tab, activate the "Enable Time-of-Day Synchronization in NTP Mode" check box.
4. Click "Add". The "Edit NTP Server Address" dialog box opens.
5. Enter the Ethernet address of the time master in the "NTP server address" text box.
5.2.4 How to configure the CP 443-5 Extended

Requirement

A CP 443-5 Extended is configured in the configuration table for the SIMATIC station (type of CP: see section "Components and Systems > Communication Modules (Page 24)").

Procedure

1. Select the CP 443-5 Extended in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Operating Mode" tab, activate the "DP master" check box.
   
   ![Properties - CP 443-5 Ext - (RO/57)](image)

4. Select the "Options" tab.
5. Activate the check box "From station to LAN" in the "Time-of-Day Synchronization" group. By activating this option, the time frames of the time master are forwarded to the PROFIBUS network.
   
   ![Properties - CP 443-5 Ext - (RO/57)](image)

6. Click "OK" to apply the settings.
5.2.5 Rules for assigning the time interval

Configuration of the time interval should be noted in the following cases:

- Configuring the PROFIBUS connection of the CPU (Page 39)
- Configuring the interface module (IM) (Page 42)

Rules for assigning the time interval

The synchronization time interval setting depends on the interface modules (IM 153-2, IM 152-1) that are connected to the DP master systems:

<table>
<thead>
<tr>
<th>Property</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>IM on the DP master system</td>
<td>If only interface modules (IM) with a variable time interval (such as the IM153-2BA00) are used on the DP master system, set the synchronization time interval of the CPU to e.g. 10 seconds.</td>
</tr>
</tbody>
</table>
| IMs with the same time interval (fixed or variable) are connected to the DP master system. | Setting for synchronization of the DP slaves:  
  - If all DP slaves on the DP master system expect a time interval of one second for the synchronization, set the time interval for the synchronization for the CPU to e.g. 1 second.  
  - If all DP slaves on the DP master system expect a time interval of ten seconds for the synchronization, set the time interval for the synchronization for the CPU to e.g. 10 seconds. |
| IMs with different time intervals (fixed or variable) are connected to the DP master system. | If you use interface modules (IM) with different time intervals on a DP master system, set the minimally required time interval for the respective DP master system (see rule for: IM with same time interval on the DP master system). |

Rules for optimization:

- Avoid multiple synchronization. Set the same interval values for all synchronizations.
  - Set the time interval for synchronization of the DP slaves.
  - Set the time interval for the time master that synchronizes the plant.
5.2.6 How to configure the PROFIBUS connection of the CPU

Requirement

The S7-400 CPU has been configured in the configuration table.

Procedure

1. Select the PROFIBUS connection of the CPU in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Operating Mode" tab, activate the "DP master" check box.
4. Select the "Clock" tab.

Note

The setting options in the "Clock" tab depend on the interface module (IM) used.
5. Select "As master" in the "Synchronization mode" list. The time frames of the time master are then forwarded to the PROFIBUS.

Note
When making a setting from the "Time Interval" drop-down list, keep in mind that the setting options depend on the interface modules (IM) used. Note the "Rules for assigning the time interval (Page 38)" section.

6. Click "OK" to apply the settings.
5.3 Configuring the ET 200M station

5.3.1 Setting options on the ET 200 station

Hierarchy of Settings

<table>
<thead>
<tr>
<th>On level ...</th>
<th>... Set in HW Config</th>
<th>Affects</th>
<th>Setting options</th>
</tr>
</thead>
</table>
| DP slave (Rack) | Interface module properties | All digital input modules in an ET 200 station | • Time stamping on/off  
• Rising or falling edge (see section “Examples of settings for IM 153-2 interface module (Page 45)” |
| Module | Digital input module properties | All channels of a digital input module | • Time stamping on/off  
• Rising or falling edge (see section “Examples of settings for SM 321 digital input module (Page 49)” |
| Channel | Digital input module properties | One single channel of a digital input module | • Time stamping on/off  
• Rising or falling edge (see section “Examples of settings for SM 321 digital input module (Page 49)” |

Note
The lower-level settings are overwritten by the activation/passivation at a high-level location (for example, on the DP slave).
5.3 Configuring the ET 200M station

5.3.2 How to configure the interface module

Requirements

- A DP master system is configured on a CP 443-5 Extended or on the PROFIBUS connection of the CPU.
- At least one digital input module that supports time stamping is configured in the ET 200 station (type of digital input module: See section "Components and Systems > Distributed I/O (Page 25)").

Setting the synchronization interval

The synchronization interval for the CPU should be set to 10 seconds for PCS 7.

Note

With some modules (for example, order no. 6ES7153-2A... ), the synchronization interval for the CPU is fixed at 1 second (increased CPU load).

Procedure

Note

If you want to configure the digital input modules individually, open the object properties for the respective digital input modules.

Additional information:

- "How to configure the SM 321 digital input module (Page 47)" section.
- "How to configure the SM 131 digital input module (Page 50)" section.

1. Select the interface module in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Name" input box on the "General" tab, enter a unique name for the interface module. A unique name makes it easier to assign program blocks in other configuration tasks and messages.

4. Open the "Time Synchronization" tab.

5. Activate the "Time synchronization" check box. If possible, select the optimum synchronization interval.

6. Open the "Time-of-day Stamp" tab.

**Note**

When selecting the synchronization interval, note the "Rules for assigning the time interval (Page 38)" section.

**Note**

The "Time-of-Day Stamp" tab is available in the "Object Properties" dialog box for the interface module only if you have configured at least one digital input module that supports time stamping in the ET 200 station (see "Setting options on the ET 200 station" (Page 41)).
7. Select the "Time-of-day stamp" check box in the "Presetting of All Inputs" group.

8. Specify the edge of the process signal from the IM that should be interpreted as an "incoming event". The opposite signal transition is interpreted as the signal exiting the state.
   Select the check box for the required signal change:
   – "Falling Edge 1 -> 0" or
   – "Rising Edge 0 -> 1"
   When the static state of a signal changes, a message is generated at this point in time.

9. Click "OK" to apply the settings.

**NOTICE**

The settings in the "DP Slave Properties" dialog box apply to all channels of the digital input modules with time stamping used in this ET 200 station. A change in the "Presetting of All Inputs" field affects the settings for all inputs of this ET 200 station.
5.3.3 Examples of settings for IM 153-2 interface module

1. Example

IM 153-2 - time stamping enabled for the entire ET 200M station (or only one module with time stamping in this ET 200M station):

![Diagram showing IM 153-2 settings with time stamping enabled.]

2. Example

IM 153-2 - time stamping disabled for the ET 200M station:

![Diagram showing IM 153-2 settings with time stamping disabled.]

3. Example

IM 153-2 - time stamping enabled for (individual) modules or (individual) channels:
5.3.4 How to configure the SM 321 digital module

Note
You only need to read this section if you want to set time stamp for each digital input module separately.

Requirements
- At least one ET 200M station is configured in HW Config.
- A digital input module SM 321 is configured in at least one slot of the ET 200M station (IM 153-2) (type of digital input module: See section "Components and Systems > Distributed I/O (Page 25)").
5.3 Configuring the ET 200M station

Procedure

1. In the ET 200M station, select the SM 321 digital input module for which you want to make the settings.
2. Open the shortcut menu (right-click) and select the menu command **Object Properties**.
3. Activate the "Time stamp" check box in the "Time stamping" tab and activate the radio button you want for RLO edge detection.

Additional information

- "Examples of settings on digital input module SM 321 (Page 49)" section
- Section "How to configure the interface module (Page 42)"
5.3.5 Examples of settings for SM 321 digital input module

1. Example

Module setting "Presetting of all inputs" selected:

![Diagram 1]

2. Example

Module setting "Individual setting of the inputs" (channel-specific) selected:

![Diagram 2]
5.3.6  How to configure the SM 131 digital module

Note
You only need to read this section if you want to set time stamp for each digital input module separately.

Requirements

- An ET 200iSP station is configured in HW Config.
- A digital input module SM 131 (8 DI NAMUR) is configured in at least one slot of the ET 200iSP station (IM 152-1) (type of digital input module: See section "Components and Systems > Distributed I/O (Page 25)").
Procedure

1. In the ET 200iSP station, select the SM 131 digital input module for which you want to make the settings.
2. Open the shortcut menu (right-click) and select the menu command Object Properties.
3. Select the "Parameters" tab.
4. In the tree view, select the folder Parameters > Time Stamp > Individual setting of the inputs.
5. In the tree view, open the folder of the channel to be changed (for example, channel 0)
6. Open the "Time stamping" parameter in the tree view. Activate the check box in the "Value" column.
7. Open the "Edge Evaluation Incoming Event" parameter in the tree view. Select the direction of the edge evaluation from the drop-down list box in the "Value" column.

Note

You now need to configure each input separately.

Configuration via the interface module affects all inputs of the digital input module in this ET 200iSP station.

8. Click "OK".
The settings are applied.

Additional information

- "Example of setting on digital input module SM 131 (Page 52)" section
- Section "How to configure the interface module (Page 42)"
5.3.7 Example of settings on the SM 131 digital input module

The settings can be made for all modules or specific channels.

Example

Setting on the module:

![Image of module settings](image-url)
5.3.8 How to configure the SM 326 digital input module

Note
You only need to read this section if you want to set time stamp for each digital input module separately.

Influence on a configured F system

Note
The activation of the high-precision time stamping has no effect on the operation of an F system if the required modules and inputs have already been configured.

Inputs available

The number of digital input module inputs available for time stamping depends on the following supplementary conditions:

- Version of the software package
  - SIMATIC S7; S7 F systems
  - SIMATIC S7; FConfigPack
- Type of interface module (IM 153-2)
  High-precision time stamping in SIMATIC S7-400F is available only for IM 153-2 interface modules with the following order numbers:
  - 6ES7153-2BA01-0XB0
  - 6ES7153-2BA02-0XB0

<table>
<thead>
<tr>
<th>Software packages</th>
<th>Interface module 6ES7153-2BA01-0XB0</th>
<th>Interface module 6ES7153-2BA02-0XB0</th>
</tr>
</thead>
<tbody>
<tr>
<td>FConfigPack V5.4 SP1 to V5.5 (S7 F systems V5.2 SP4)</td>
<td>High-precision time stamp not available</td>
<td></td>
</tr>
<tr>
<td>FConfigPack V5.5 SP1 and V5.5 SP2 (S7 F systems V5.2 SP4)</td>
<td>12 channels available (CH00 to CH11)</td>
<td></td>
</tr>
<tr>
<td>FConfigPack as of V5.5 SP3 (S7 F systems V6.0)</td>
<td>12 channels available (CH00 to CH11)</td>
<td>24 channels available (CH00 to CH23)</td>
</tr>
</tbody>
</table>

Requirements

- An ET 200M station is configured in HW Config.
- A digital input module SM 326 is configured in a slot of the ET 200M station (IM 153-2) (type of digital input module: See section "Components and Systems > Distributed I/O (Page 25)").
Procedure

1. In the ET 200M station, select the SM 326 digital input module for which you want to make the settings.
2. Open the shortcut menu (right-click) and select the menu command Object Properties.
3. Select the "Parameters" tab.
4. In the tree view, select the folder Parameters > Time Stamping > Individual setting of the inputs.
5. In the tree view, open the folder of the channel to be changed (for example, channel 0)
6. Open the "Time stamping" parameter in the tree view. Activate the check box in the "Value" column.
7. Open the "Edge Evaluation Incoming Event" parameter in the tree view. Select the direction of the edge evaluation from the drop-down list box in the "Value" column.

Note
You now need to configure each input separately.
Configuration via the interface module affects all inputs of the digital input module in this ET 200M station.

8. Click "OK".
The settings are applied.

Additional information

- Section "Examples of settings on digital input module SM 326 section (Page 55)"
- Section "How to configure the interface module (Page 42)"
5.3.9 Examples of settings on digital input module SM 326 section

The settings for each module must be made for specific channels. Configuration via the interface module affects all inputs of the digital input module in this ET 200M station.

Example

Setting on the module:
5.4 Configuring symbolic names

5.4.1 How to configure symbolic names for signals

Introduction
You can assign symbolic names to signals. Simple identification of the signals makes the interconnection of the driver blocks easier.

Requirements
- The project is open in the Component View of SIMATIC Manager.
- The path to the AS is set.
- HW Config is open.

Procedure
Perform the following tasks for all digital input modules:
1. Select a digital input module in HW Config.
2. In the configuration table for the module, select a row in which an address of the process image is assigned.
3. Select the menu command **Edit > Edit Symbols**.

4. Enter the symbols (symbolic names) for the assigned inputs of modules with time stamping.
   You can apply the addresses as symbols by clicking the "Add to Symbol" button. You can change the symbol name in the "Edit Symbols" dialog box or in the symbol table (for example, Symbol = "Chart_Meas" - a maximum of 24 character are allowed).

![Edit Symbols - DI16xDC24V, Alarm](image)
5.5 Configuring the signaling block

5.5.1 How to prepare for message configuration

You must configure one of the signaling blocks in CFC charts so that messages with high-precision time stamps can be displayed on the OS.

Signaling blocks may be:

- **MSG_TS block**
  A MSG_TS block can generate the messages for up to 16 digital inputs.

- **Blocks from the Advanced Process Library**
  - The special digital inputs (ExtMsg) of the technology blocks for motors and valves can send messages with high-precision time stamps.
  - EventTS block

**Procedure**

Create a CFC chart with a signaling block.
5.6 Configuring the input signals

5.6.1 How to configure the input signals

Procedure

1. Select the "VALUE, VALUE_00" input of the channel driver block (CH_DI or Pcs7DiIT) in the CFC chart.

2. Select the menu command **Insert > Interconnection to Address**. The "Insert Interconnection to Address" dialog box opens.

3. Select the row with the corresponding module input and double-click in the row.

4. Connect the blocks as shown for the connections in the following examples.

**Note**

You can configure messages assigned to the module input directly at the signaling block when you configure an input signal, or you can configure them later. You can find additional information in the section "Configuring messages for high-precision time stamping (Page 63)".

<table>
<thead>
<tr>
<th>Input 0.0</th>
<th>BOOL</th>
<th>I</th>
<th>0.0</th>
<th>Input 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>IO.1</td>
<td>BOOL</td>
<td>I</td>
<td>0.1</td>
<td></td>
</tr>
<tr>
<td>IO.2</td>
<td>BOOL</td>
<td>I</td>
<td>0.2</td>
<td></td>
</tr>
<tr>
<td>IO.3</td>
<td>BOOL</td>
<td>I</td>
<td>0.3</td>
<td></td>
</tr>
<tr>
<td>IO.4</td>
<td>BOOL</td>
<td>I</td>
<td>0.4</td>
<td></td>
</tr>
<tr>
<td>IO.5</td>
<td>BOOL</td>
<td>I</td>
<td>0.5</td>
<td></td>
</tr>
<tr>
<td>IO.6</td>
<td>BOOL</td>
<td>I</td>
<td>0.6</td>
<td></td>
</tr>
<tr>
<td>IO.7</td>
<td>BOOL</td>
<td>I</td>
<td>0.7</td>
<td></td>
</tr>
</tbody>
</table>
Example of configuration with the PCS 7 library

The following figure provides an example of high-precision time stamping for the "MSG_Ts" block.

The following I/Os are interconnected:
- "E0.0" input of the module with the "Value" input of the CH_DI block
- "E0.0" input of the module with the "Value_00" input of the MSG_TS message block (example)

![Configured interconnection of an input with high-precision time stamping](image)

Note
Configuration for an F system
Position the MSG_TS block in a CFC chart that is not in the runtime group of the F blocks. It is not possible to forward time stamps to technology blocks via the channel driver blocks of the F libraries.

Example of configuration with a technology block from the Advanced Process Library (APL)

Note
Making the inputs visible
You must make the following inputs of the technology blocks visible:
- TimeStam
  This input activates the high-precision alarm inputs when the value = 1.
- ExtMsgT1 to ExtMsgT6
  These six inputs are the alarm inputs of the technology block for the high-precision time stamp.
The following figure provides an example of high-precision time stamping for the "StartAut" input of the "MotL" block.

- "TimeStam" input at "MotL" block = 1
- The following I/Os are interconnected:
  - Module, "E1.0" input with the "PV_In" input of the Pcs7DiIT channel driver block
  - "TS_Out" output of the Pcs7DiIT channel driver block with "ExtMsgT1" input of the MotL block.
  - "PV_Out" output of the Pcs7DiIT channel driver block with the "StartAut" input of the MotL block.

- The message should be configured at the MotL block. Replace the default text (such as $BlockComment$ External message 1 status @5%d@) with the message text (such as Motor 1; START AUTO).
Example of configuration with the EventTS block from the Advanced Process Library (APL)

The following figure provides an example of high-precision time stamping for the "InTS1" input of the "EventTS" block.

The following I/Os are interconnected:
- "E0.0" input of the module with the "PV_In" input of the Pcs7DiIT block
- "PV_OUT" output of the Pcs7DiIT block with the "In1" input EventTS block
- "TS_OUT" output of the Pcs7DiIT block with the "InTS1" input EventTS block

Notes on configuration with redundant signal acquisition

Take into account the following information for a configuration with redundant signal acquisition:
- It is possible to mix redundant and non-redundant DI signals.
- With redundant signal acquisition, a message is produced for the OS for each module input regardless of the module status (passivated, good status).

Additional information

You will find more information on configuration with redundant signal acquisition in the function manual Process Control System PCS 7; Fault-Tolerant Process Control Systems.
5.7 Configuring messages for high-precision time stamping

5.7.1 How to configure messages with the MSG_TS block

Introduction

This section explains how to change the message text for signals with time stamping when using the PCS 7 Library. Adapt the message texts according to the requirements of the PCS 7 system.

Procedure

1. Open the project in SIMATIC Manager and select the menu command View > Component View.
2. Select the chart folder of a S7 program in the tree: Project\SIMATIC Station\CPU\S7 Program\Charts.
3. Select the menu command Options > Charts > Chart Reference Data. The "Chart Ref: Display Chart Reference Data" dialog box opens.
4. Select the menu command View > Block Types. The "{S7 Program} (Block Types)" dialog box opens.
5. Click "Block type" in the table heading. The entries are sorted alphabetically.
6. Find the MSG_TS block with the associated entries in the list. Example for PCS 7 library and MSG_TS block:
   - Table column "Block Type" = MSG_TS
   - Table column "Block" = name of block in the specific plant
7. Double-click on the "MSG_TS" block type in the found table row. The CFC chart containing the MSG_TS block opens. The relevant block is highlighted.
8. Select the menu command Edit > Object Properties. The "Properties – Block" dialog box opens.
9. Click "Messages" in the "Special Properties" group. The "PCS 7 Message Configuration" dialog box opens.
10. Change the message text as required in the "Event" area of the table:
    - The "EV_ID_01" area contains the message identifier
    - The "EV_ID_02" identifier contains the text of the signal-specific user messages
11. Click "OK".

Additional information

You can find additional information about message configuration in the STEP 7 online help under the topic "How to Create Block-Related Messages for the Project."
5.7 Configuring messages for high-precision time stamping

5.7.2 How to configure messages with blocks of the Advanced Process Library (APL)

Introduction

This section explains how to change the message text when using the Advanced Process Library (APL).

The following blocks can send messages from signals with high-precision time stamps:

- EventTS
- APL technology blocks, such as MotL

Adapt the message text according to the requirements of the PCS 7 system.

Procedure

1. Open the project in SIMATIC Manager and select the menu command View > Component View.
2. Select the chart folder of a S7 program in the tree: Project\SIMATIC Station\CPU\S7 Program\Charts.
3. Select the menu command Options > Charts > Chart Reference Data.
   The "Chart Ref: Display Chart Reference Data" dialog box opens.
4. Select the menu command View > Block Types.
   The "(S7 Program) (Block Types)" dialog box opens.
5. Click "Block type" in the table heading.
   The entries are sorted alphabetically.
6. Find the signaling block with the associated entries in the list.
   Example for the "MotL" APL block:
   - Table column "Block Type" = MotL
   - Table column "Block" = name of block in the specific plant
7. Double-click the block type of the signaling block (such as MotL) in the found table row.
   The CFC chart containing the required block (such as MotL) opens. The relevant block is highlighted.
8. Select the Edit > Object Properties
   The "Properties – Block" dialog box opens.
9. Click "Messages" in the "Special Properties" group. The "PCS 7 Message Configuration" dialog box opens.
10. Change the message text of the signal-specific user messages for the message identifier area in the "Event" column of the table.
    - For technology blocks, the message identifier area "MsgEvId_02" contains the text of the signal-specific user messages.
    - For the EventTS block, the message identifier area "MsgEvId" contains the text of the signal-specific user messages.
11. Click "OK".
Additional information

You can find additional information about message configuration in the STEP 7 online help under the topic "How to Create Block-Related Messages for the Project)."
5.8 Compiling and downloading the AS

5.8.1 How to compile and download the AS

Options

The following options are available for compiling and downloading programs:

- You can use the commands for a single SIMATIC station.
- You can compile and download multiple SIMATIC stations with a single command.

Additional information

You can find additional information and step-by-step instructions in the configuration manual *Process Control System PCS 7; Engineering System.*
5.9 Compiling and downloading the OS

5.9.1 How to compile and download the OS

Options

The following options are available for compiling and downloading the operator station(s):

- You can compile and download operator stations one-by-one.
- You can compile several operator stations at the same time and download them on their own.
- You can compile and download several operator stations at the same time.

Additional information

You can find additional information and step-by-step instructions in the configuration manual Process Control System PCS 7, Operator Station.
AS Process Control Messages for
Time Stamp Faults

6.1 Time stamp faults

Introduction
This section describes the AS process control messages that are generated when faults occur in the time stamping.

Overview of AS process control messages
The following AS process control messages can be generated for time stamp faults:

- Startup data (Page 70)
- Time-of-day message frame error (Page 72)
- Time difference between the message frame time stamp and the real-time clock may cause inaccuracy (Page 73)
- STOP of the time stamp function (Page 74)
- Message loss at IM (buffer overflow) (Page 75)
- Redundant changeover (Page 76)
- Loss of information with redundancy (Page 77)

Additional information
Additional information about editing the message texts is available in the section "Configuring time stamping > Configuring message texts for high-precision time stamping" > How to configure messages for high-precision time stamp (Page 63).
6.2 AS process control message "Startup data"

Meaning

The AS process control message "Startup data" indicates a start/restart of the interface modules (for example, IM 153-2).

Messages

- "Startup data" with the signal status "INCOMING"
- "Startup data" with the signal status "OUTGOING"

Description

1. After the start/restart, the interface module sends the signal for the AS process control message "Startup data" with the signal status "INCOMING" to the CPU.

2. The interface module then sends messages signaling the static state of all configured process signals.
   Based on the process signal, the interface module derives the signal to be sent according to the configuration (see following table).

3. Following this, the interface module sends the signal for the AS process control message "Startup data" with the signal status "OUTGOING".

<table>
<thead>
<tr>
<th>Status process signal</th>
<th>Configured edge evaluation of incoming event:</th>
<th>Interface module (signal message from startup)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 -&gt; 1</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>1</td>
<td>0 -&gt; 1</td>
<td>INCOMING</td>
</tr>
<tr>
<td>1</td>
<td>1 -&gt; 0</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>0</td>
<td>1 -&gt; 0</td>
<td>INCOMING</td>
</tr>
</tbody>
</table>

Message derived from the process signal (depending on configuration)
Message processing in PCS 7

1. The signal for "Startup data" with the signal status "INCOMING" is detected and the AS process control message "Startup data" is entered in the message list with the signal status "INCOMING".

2. In the CPU, the message block compares the signal messages representing the static state of the process signals with the last stored state of the signals. If there are signals whose states are different, messages are entered in the message list (see following table):

3. The OS identifies the signal for the startup data. The AS process control message "Startup data" is entered in the message list with the signal status "OUTGOING".

<table>
<thead>
<tr>
<th>Interface module (signal message from startup)</th>
<th>Value stored in the CPU (message block)</th>
<th>Message in message list and archive</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCOMING</td>
<td>INCOMING</td>
<td>---</td>
</tr>
<tr>
<td>INCOMING</td>
<td>OUTGOING</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>OUTGOING</td>
<td>OUTGOING</td>
<td>-----</td>
</tr>
<tr>
<td>OUTGOING</td>
<td>INCOMING</td>
<td>INCOMING</td>
</tr>
</tbody>
</table>

Possible status of a message in the message list
6.3 AS process control message "Time-of-day message frame error"

Meaning

The AS process control message "Time-of-day message frame error" indicates an error in the time-of-day synchronization of the interface module (for example, IM 153-2).

Messages

- "Time-of-day message frame error" with the signal status "INCOMING"
- "Time-of-day message frame error" with the signal status "OUTGOING"

Description

The interface module expects a time-of-day frame from the time master within the configured interval (every second, for example).

If the time-of-day frame of the master is not received three times in succession, the interface module continues to operate with the internal time and sends the message "Time-of-day message frame error" with the signal status "INCOMING" to the operator station.

Once the next valid time-of-day frame arrives, the internal clock of the interface module is synchronized and the message "Time-of-day message frame error" with the signal status "OUTGOING" is triggered.
6.4 AS process control message "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy"

Meaning

The AS process control message "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" indicates a time change or time difference in the interface module (for example, IM 153-2).

Messages

- "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" with the signal status "INCOMING"
- "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" with the signal status "OUTGOING"

Description

The two messages are sent one after the other in the following situation:

- When a signal arrives at the interface module, there is a difference between the synchronous time and the internal time of the interface module.
- The difference between the times is greater than half the accuracy of the time stamp.

Example: The difference is > 5 ms with time stamping accuracy of 10 ms.

The time of the interface module is then synchronized.

- The message with the signal status "INCOMING" receives the time stamp before synchronization.
- The message with the signal status "OUTGOING" receives the time stamp after synchronization.

Based on these messages, you can check whether the internal clock of the interface module has been set forward or back.
6.5 AS process control message "STOP of the time stamp function"

Meaning

The AS process control message "STOP of the time stamp function" indicates a time stamp fault of the interface module (for example, IM 153-2).

Messages

- "STOP of the time stamp function" with the signal status "INCOMING"
- "STOP of the time stamp function" with the signal status "OUTGOING"

Description

If the connection between the DP master and the interface module breaks down, signals are no longer given time stamps. The might occur, for example, following failure of the CP or a break on the bus cable. A message to this effect is entered in the internal message list.

- Signal time stamping is stopped from the moment the message with the signal status "INCOMING" is generated.
- Signal time stamping is reactivated once the message with the signal status "OUTGOING" is generated.
- Once the message "STOP of the time stamp function" with the signal status "OUTGOING" is generated, the interface module starts up again.
6.6 AS process control message "Message loss at IM (buffer overflow)"

Meaning

The AS process control message "Message loss at IM (buffer overflow)" indicates a loss of messages due to an overflow of the message buffer of the interface module.

Messages

- "Message loss at IM (buffer overflow)" with the signal status "INCOMING"
- "Message loss at IM (buffer overflow)" with the signal status "OUTGOING"

Description

The AS process control message is generated in the two following situations:

<table>
<thead>
<tr>
<th>Buffer overflow due to external causes</th>
<th>Buffer overflow due to internal causes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examples of potential causes:</td>
<td>Example of a potential cause:</td>
</tr>
<tr>
<td>- Failure or overload of the plant or field bus</td>
<td>The signals in the I/O change so quickly that the signal transitions can no longer be entered in the message lists.</td>
</tr>
<tr>
<td>- Failure or overload of the DP master (CPU)</td>
<td>Remedy: Distribute the signals over several interface modules or reduce the number of signals with time stamping.</td>
</tr>
<tr>
<td>Remedy: Correct the source of the problem</td>
<td></td>
</tr>
</tbody>
</table>

A message to this effect is entered in the internal message list.

- Incoming messages cannot be saved from the moment the message with the signal status "INCOMING" is generated.
- Incoming messages can be saved again once the message with the signal status "OUTGOING" has been generated.
6.7 AS process control message "Redundant changeover"

Meaning

The AS process control message "Redundant changeover" is output when there is a changeover between active and passive interface modules (for example, IM 153-2).

Messages

- "Redundant changeover" with the signal status "INCOMING"
- "Redundant changeover" with the signal status "OUTGOING"

Description

The AS process control message "Redundant changeover" indicates this period of interruption.

- Time stamps are not applied during the period of the failover.
- Time stamping is deactivated from the moment the message with the signal status "INCOMING" is generated (start of the failover between the active and passive interface modules).
- Time stamping is reactivated once the message with the signal status "OUTGOING" is generated.
6.8 AS process control message "Loss of information with redundancy"

Meaning

The AS process control message "Loss of information with redundancy" indicates an error when signals are exchanged between the passive interface module (for example, IM 153-2) and the active interface module.

Messages

- "Loss of information with redundancy" with the "INCOMING" signal status
- "Loss of information with redundancy" with the "OUTGOING" signal status

Description

During error-free operation, the passive interface module receives information about the current state of the I/O from the active interface module:

- There is a signal exchange error from the moment the message with the signal status "INCOMING" is generated.
- As soon as the I/O state has been synchronized between the active and passive interface modules, the message with the signal status "OUTGOING" is output.
AS Process Control Messages for Time Stamp Faults

6.8 AS process control message "Loss of information with redundancy"
Index

A
Advanced Process Library, 29
APL, 29
AS, 66
  compiling and downloading, 66
  AS process control messages, 69, 70, 72, 73, 74, 75, 76, 77
  Loss of information with redundancy, 77
  Message loss at IM (buffer overflow), 75
  Redundant changeover, 76
  Startup data, 70
  STOP of the time stamp function, 74
  Time difference between the message frame time stamp and the real-time clock may cause inaccuracy, 73
  Time-of-day message frame error, 72

C
Communication, 24
to operator station, 24
Communication modules, 24
CP 443-1, 24
CP 443-5 Extended, 24
For time stamping, 24
Compile, 66, 67
  AS, 66
  OS, 67
Configuration, 17, 56, 59
  APL, 80
  APL (EventTS), 82
  Input signals, 59
  Note, 17
  PCS 7 Library, 60
  Redundancy, 82
  Symbols, 56
Configure, 33, 34, 37, 39, 42, 47
  CP 443-1 Industrial Ethernet, 34
  CP 443-5 Extended, 37
  CPs, 33
  Digital input module SM 321, 47
  Interface module IM 153-2, 42
  PROFIBUS connection of the CPU, 39
  CP 443-1 Industrial Ethernet, 34
  Configure, 34
  CP 443-5 Extended, 37
  Configure, 37
  CPs, 33
  Configure, 33

D
Digital input module SM 131, 52
  Configure, 50, 52
Digital input module SM 321, 47, 49
  Configure, 47
  Settings, example, 49
Digital input module SM 326, 55
  Configure, 53, 55
Digital input modules, 26
Distributed I/O, 25
  for signal acquisition, 25
  Supported modules, 25
Download, 66
  AS, 66

E
Environmental requirements
  Higher, 26
ET 200iSP, 50, 52
  Digital input module example, 52
  SM 131 Example, 52
  SM131, 50
ET 200M, 53, 55
  Digital input module example, 55
  SM 326 Example, 55
  SM326, 53
ET 200M station, 41
  Settings for time stamping, 41
EventTS block
  Note, 29
Examples, 18, 45, 49
  Plant with time stamping, 18
  Redundant plant with time stamping, 18
  Settings for interface module IM 153-2, 45
  Settings on the digital input module SM 321, 49

F
Faults, 69
  in time stamping, 69
Index

H
High-precision time stamping with 1 ms accuracy, 21

I
IM 153-2, 20
Message loss, 20
Signal surge, 20
Special features, 20
IMDRV_TS block
Note, 29
using for time stamping, 27
IMDRV_TS block, 27
Input signals, 59
Configuring, 59
Interface module IM 153-2, 42, 45
Configure, 42
Examples of settings, 45
Interface modules, 25

L
Loss of information with redundancy, 77

M
Message loss, 20
IM 153-2, 20
Messages, 69, 70, 72, 73, 74, 75, 76, 77
Fault in time stamping, 69
Loss of information with redundancy, 77
Message loss at IM (buffer overflow), 75
Redundant changeover, 76
Startup data, 70
STOP of the time stamp function, 74
Time difference between the message frame time stamp and the real-time clock may cause inaccuracy, 73
Time-of-day message frame error, 72
MSG_TS block, 28

N
Note
on the MSG_TS block, 28

O
Operator station, 24
Communication to CPU, 24
OS, 67
Compile, 67

P
Plant with time stamping, 18
Example, 18
Precision, 9
Time stamping, 9
Preface, 5
PROFIBUS connection of the CPU, 39
Configure, 39

R
Redundancy, 62
Redundant changeover, 76
AS process control message, 76
Redundant plant with time stamping, 18
Example, 18

S
Sequence, 12
Time stamping, 12
Settings, 45, 49
Digital input module SM 321, examples, 49
Interface module IM 153-2, Examples, 45
Signal acquisition, 25
Supported modules, 25
Via distributed I/O, 25
Signal surge, 20
On the IM 153-2, 20
Signals, 56
assigning symbolic names, 56
SIPLUS modules, 26
SM 131, 52
Example, 52
SM 326, 55
Example, 55
Startup data, 70
AS process control message, 70
STOP of the time stamp function, 74
AS process control messages, 74
Symbolic names, 56
assigning for signals, 56
Symbols, 56
Configuring, 56
System planning, 17
   Note, 17

T
Time difference between the message frame time stamp and the real-time clock may cause inaccuracy, 73
   AS process control message, 73
   Time master, 30
   Time stamping, 9, 18, 24, 27, 41, 69
      Communication modules, 24
      CPU used, 24
      Functionality, 9
      Messages for faults, 69
      Plant configuration, 18
      Precision, 9
      Requirements, 9
      Resolution, 9
      Sequence, 12
      Settings on the ET 200M station, 41
      using, 8
      Using the IMDRV_TS block, 27
   Time stamping (10 ms), 9
   Time Stamping in the Interface Module, 14
   Time-of-day message frame error, 72
      Messages, 72

U
Using, 8, 27
   IMDRV_TS block for time stamping, 27
   Time stamping, 9
Index